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Evaluation Board for the ADAS3022 16-Bit, 8-Channel,
1 MSPS Data Acquisition System

FEATURES

Full-featured evaluation board for the ADAS3022

Versatile analog signal conditioning circuitry

On-board reference, clock oscillator, and buffers

Converter evaluation and development board (EVAL-CED12)
compatible

PC software for control and data analysis (time and
frequency domain)

KIT CONTENTS
EVAL-ADAS3022EDZ evaluation board

ADDITIONAL EQUIPMENT NEEDED

EVAL-CED1Z board

Precision signal source

World-compatible 7 V dc supply (enclosed with EVAL-CED1Z)
USB cable

EVALUATION BOARD DESCRIPTION

The EVAL-ADAS3022EDZ is an evaluation board for the
ADAS3022 16-bit data acquisition system (DAS). This device
integrates an 8-channel multiplexer, a high impedance
programmable gain instrumentation amplifier (PGIA) stage with
a high common-mode rejection, a precision 16-bit successive

ADAS3022
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approximation (no latency) analog-to-digital converter and
precision 4.096 V reference offering an aggregate throughput
of 1 million samples per second (1 MSPS).

The evaluation board is designed to demonstrate the perform-
ance of the ADAS3022 and to provide an easy-to-understand
interface for a variety of system applications. A full description
of this product is available in the data sheet and should be
consulted when utilizing this evaluation board.

The evaluation board is intended to be used with the Analog
Devices, Inc., converter evaluation and development (CED)
board, EVAL-CED1Z, a USB-based capture board connected
to P4, the 96-pin interface.

On-board components include a high precision, buffered band
gap 4.096 V reference (ADR434), reference buffers (AD8032),
passive signal conditioning circuitry, and an FPGA for deserializing
the serial conversion results and configuring the ADAS3022 via
a 4-wire serial interface.

The P3 connector allows users to test their own interface with
or without the optional Altera FPGA, U6 (programmed using
the P2 and passive serial EEPROM, U5).

FPGA
PROGRAMMING
PORT

FPGA

96-PIN
INTERFACE

40-PIN IDC
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Figure 1. EVAL-ADAS3022EDZ Evaluation Board
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EVALUATION BOARD HARDWARE

OVERVIEW

The EVAL-ADAS3022EDZ evaluation board is designed to
offer a simple evaluation of these revolutionary devices. From
a block diagram perspective, the board uses a set of analog
input test points (or an IDC header), some passive footprints
for RC filtering and external reference, the ADAS3022 device,
a serial interface to the on-board FPGA, and power that can be
supplied locally or via EVAL-CED1Z or externally. Note that
the ADAS3022 devices also have an on-chip reference; however,
external circuitry is provided for users wanting to test other
suitable options.

The small prototyping area can be useful for building additional
circuitry, if desired. Each block has a specific function as
defined in the following sections.

DEVICE DESCRIPTION

The ADAS3022 is a complete data acquisition system (DAS)
on a single chip that is capable of converting up to 1 MSPS and
can resolve 8 single-ended inputs or 4 fully differential inputs up
to £24.576 V when using +15 V supplies. It can accept the
commonly used bipolar differential, bipolar single-ended, pseudo
bipolar, or pseudo unipolar input signals as shown in Table 1 thus
allowing the use of almost any direct sensor interface.

The ADAS3022 is an ideal replacement for a typical 16-bit

1 MSPS precision data acquisition system that simplifies the
design challenges by eliminating signal buffering, level shifting,
amplification/attenuation, common-mode rejection, settling
time, or any of the other analog signal conditioning challenges
while allowing smaller form factor, faster time to market, and
lower costs.

Data communication to and from the ADAS3022 occurs
asynchronously without any pipeline delay using a common
4-wire serial interface compatible with SPI, FPGA, and DSP.

A rising edge on CNV samples the differential analog inputs of
a channel or channel pair. The ADAS3022 configuration register
allows the user to configure the number of enabled channels, the
differential input voltage range, and the interface mode using the
evaluation board and software as detailed in this user guide.
Complete specifications for the ADAS3022 are provided in the
product data sheet and should be consulted in conjunction with
this user guide when using the evaluation board. Full details on
the EVAL-CEDI1Z are available on the Analog Devices website.

Table 1. Typical Input Range Selection

Signals Input Range, Vin (V)
Differential
1V +1.28V
+25V +2.56V
5V +10.24V
+10V +20.48V
Single Ended'
OVto1V +0.64V
0Vto25V +1.28V
OVto5V +2.56V
OVto10V +5.12V

! Vem adjusted to half the maximum input voltage.

JUMPERS, SOLDER PADS, AND TEST POINTS

Numerous solder pads and test points are provided on the
evaluation board and are detailed fully in Table 4, Table 5,

and Table 6. Note the nomenclature for this evaluation board
for a signal that is also connected to an IDC connector would
be signal_I. The two 3-pin user selectable jumpers are used for
the ADCs reference selection and are fully described in the
Reference section.

ANALOG INTERFACE

The analog interface is provided with test points for each of the
analog inputs IN[7:0] and COM (that is, INO_I is common to
both the test point and to P1). The passive device footprints

can be used for filtering, if desired. A simple RC filter made up
of 22 ) and 2700 pF NPO capacitors is provided. Note that

the use of stable dielectric capacitors, such as NPO or COG, is
required in the analog signal path to preserve the ADAS3022
distortion. Using X5R or other capacitors in the analog signal
path greatly reduces the performance of the system. Also, note
that many bench top arbitrary waveform generators (AWGs)
use 12-bit or 14-bit digital-to-analog converter outputs such
that the 16-bit ADAS3022 devices digitize this directly resulting
in erroneous looking data. If such an AWG is used, a high-order
band-pass filter should be used to filter the unwanted noise
from these sources.

The ADAS3022 COM input can be routed to P1 or GND using
P31. Set the jumper across Pin 1 and Pin 2 to route to P1. Set
the jumper across Pin 2 to Pin 3 to GND COM. This is useful
for single-ended applications.

For dynamic performance, an FFT test can be done by applying
a very low distortion ac source, such as an Audio Precision
System 2702. This source can be set for balanced or unbalanced,
and can be floated or grounded depending on the user’s choice.
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FPGA

The on-board FPGA performs a number of digital functions,
one of them being the sample rate conversion controlled
using the software. Another function is deserializing the
serial conversion results as the CED data capture board uses

a 16-bit parallel interface. If desired, the deserialized data can
be monitored on the 96-pin edge connecter P1, BD[15:0]. The
CED uses a buffered busy signal, BBUSY, as the general
interrupt for the data transfer to the CED board.

The FPGA also provides the necessary ADAS3022 asynchron-
ous control signals for RESET and power down (PD).

The signals from the FPGA to the ADAS3022 can be bypassed
by modifying the default solder pad connections. As shown
in Figure 2, each digital signal on the ADAS3022 is connected
to the larger (top) pad of the three. The default configuration
is the small pad and larger pad (no text) which connects the
FPGA to the ADAS3022 (CNV, BUSY, and SDO signals
shown). The labeled pads, CNV_I, BUSY_I, SDO_I, and so
on, are the signals that are routed to P3. To use P3 instead of the
FPGA, unsolder the default connections and resolder from the
large pad to the xxx_I pads. The FPGA will remain powered;
however, if all the signals are bypassed in this fashion, it will
not have any influence on the ADAS3022.

DEFAULT

CONNECTION TO P3

11064-003

Figure 2. Digital Interface Solder Pads—Partial View
Serial Interface

The 4-wire serial interface consisting of CS, DIN, SCK, and
SDO is present on the digital interface test points and is
controlled by the FPGA. The FPGA can be bypassed by using
the solder pads.

REFERENCE

The ADAS3022 has an internal 4.096 V reference, along with an
internal buffer, useful for using an external reference or one can
use an external 4.096 V reference directly, such as the ADR434
provided on the evaluation board. The evaluation board can be
configured to use any of these references. Two jumpers (P5

and P9) are used for setting the reference in conjunction with
software control.

External Reference-Factory Configuration

The evaluation board includes the ADR434, A1, which is a
4.096 V precision voltage reference. This reference can drive
the ADC REF1 or REF2 (REFx) pin directly or it can also be
buffered with U20, the AD8032; both of these are set to the
factory default setting.

Table 2. Factory Reference Jumper Configuration

Jumper Setting
P5 REFIN to GND'
P9 REF to BUF (U20)

'The connection is made through R102 = 10 k to GND.

To use another reference source, there are two methods:

e  For an external unbuffered reference, remove the P9
jumper and connect a source to the REF test point.

e  Since the ADR434 is a standard 8-lead SOIC, it can also
be removed and replaced with the user’s reference. In this
case, the user reference and the U20 AD8032 buffer can
be used as a reference source.

Internal 4.096 V Reference

The ADC has an internal 4.096 V precision reference and

can be used on most applications. When enabled, 4.096 V will
be present on the ADAS3022 REFx pin and test point, REF. In
addition, a voltage will also be present on the ADAS3022
REFIN pin and test point, REFIN. The voltage present on
REFIN can be used for other purposes, such as to provide the
bias voltage; however, it would need a suitable buffer as the
output impedance of the REFIN is on the order of a few kilo
ohms and loading this voltage down will degrade the internal
reference’s performance.

Table 3. Internal Reference Jumper Configuration

Jumper Setting
P5 Open
P9 Open

Note that the ADAS3022 configuration register needs to be
updated either using the included software or by writing the
appropriate bits to enable the internal reference.

Internal Reference Buffer

The internal reference buffer is useful when using an external
2.5V reference. When using the internal reference buffer,
applying 2.5 V to REFIN, which is directly connected to the
ADC’s REFIN pin, produces 4.096 V at the ADCs REFx pin
and REF test point.

Note that the ADAS3022 configuration register needs to be
updated either using the included software or by writing the
appropriate bits to enable the internal reference buffer.
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POWER SUPPLIES AND GROUNDING

The on-board ADP3334 low dropout regulators are provided
for 2.5V, 3.3V, and 5V and also for the FPGA 1/O supply
which is user configurable and set to 3.3 V by default. The
FPGA core is supplied by a pair of ADP1715 devices set for
1.2 V. Additional power is supplies via the CED board for an
alternative +5 V analog and digital 3.3 V/5 V digital through P4.

The ADAS3022 device also requires +15 V supplies for
VDDH and VSSH. These must be supplied by the user using
a standard lab supply ensuring that the return paths are at the
same potential. Refer to CN-0201 for the complete information
on generating these 15 V supplies from a +5 V single supply.
The differential input common-mode voltage (VCM) range
changes according to the maximum input range selected and
the high voltage power supplies (VDDH and VSSH). In other
words, the specified operating input voltage of any input pin
requires 2.5 V of headroom from the VDDH and VSSH
supplies.

The evaluation board ground plane consists of a solid plane

on one PCB layer shared on another layer with the power plane.

To attain high resolution performance, the board was designed
to ensure that all digital ground return paths do not cross the
analog ground return paths, that is, all analog on one side and
digital on the other.

EVALUATION BOARD SCHEMATICS/PCB LAYOUT

The evaluation board is a 6-layer board carefully laid out and
tested to demonstrate the specific high accuracy performance

EVAL-ADAS3022EDZ

SIGNAL SOURCE

of the ADAS3022 devices. The Evaluation Board Schematics
and Artwork section of this user guide shows the schematics of
the evaluation board.

BASIC HARDWARE SETUP

The ADAS3022 evaluation board connects to the EVAL-CED1Z
converter evaluation and demonstration board. The EVAL-
CED1Z board is the controller board, which is the communi-
cation link between the PC and the main evaluation board.

Figure 3 shows a photograph of the connections made between
the ADAS3022 daughter board and the EVAL-CED1Z board.

1. Before connecting power, ensure that the EVAL-
ADAS3022EDZ and the EVAL-CED1Z boards are
connected firmly together.

2. Connect the power supplies on the EVAL-ADAS3022EDZ
board. The EVAL-ADAS3022EDZ requires external power
supplies of +15 V. Connect them from a bench top power
supply.

3. Connect the EVAL-CED1Z board to the PC via the USB
cable enclosed in the EVAL-SDPCB1Z kit. If using a
Windows® XP platform, you may need to search for the
EVAL-CEDIZ drivers. Choose to automatically search for
the drivers for the EVAL-CED1Z board if prompted by the
operating system.

4. Proceed to the Software Installation section to install the
software. Note that the EVAL-CED1Z board must not
be connected to the PC’s USB port until the software is
installed. The 7 V dc supply can be connected, however,
to check that the board has power (green LED lit).

EVAI D1Z

— TO WALL WART

11064-002

Figure 3. Hardware Configuration—Setting up the EVAL-ADAS3022EDZ
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JUMPERS AND TEST POINTS

Three-pin jumpers are used to configure the ADC reference. Refer to the Reference section for further details and settings.

Table 4. Pin Jumper Descriptions

Jumper | Default Function
P5 REFIN to REFIN Select. Buffered reference input selection. Use in conjunction with P7.
GND Note that the ADAS3022 REFx pin and any other circuit traces/test points will produce 4.096 V when using the
buffered reference configuration; P7 must be left in the open position.
REFIN to A2: Uses the on-board ADR381, A2 (2.5 V) reference. The ADAS3022 must use the buffered reference
configuration.
REFIN to GND: Disables the ADAS3022 internal reference. The ADAS3022 must use the full external reference
configuration.
Open: For use either when using the ADAS3022 on-chip reference or when applying an external 2.5V source. When
using the on chip reference, a voltage is present on Pin 2 and any other circuit traces/test points. When using an
external source, the ADAS3022 must use the buffered reference configuration.
P7 REF to REF Select. External 4.096 V reference input selection. Use in conjunction with P5. Note that the ADAS3022 REFIN
BUF pin and any other circuit traces/test points produce 2.5V when using the internal or external reference
configuration and P5 must be left in the open position.
REF to A1: Uses the on-board ADR434, A1 (4.096 V), reference. The ADAS3022 must use the external reference
configuration.
REF to BUF: Uses the on-board ADR434 followed by the AD8032, U20 unity gain buffer. This allows some adjustment
to the reference voltage by use of some resistors around the AD8032. The ADAS3022 must use the external
reference configuration.
Open: For use when using the ADAS3022 on-chip reference or an externally applied source connected directly to
Pin 2 or the REF test point.
P31 COMto COM Input Select. Center pin connected to ADAS3022 COM pin. Center pin to PIN1 routes COM to P1. Center to
PIN 1 PIN3 routes COM to GND.

Solder pads jumpers are factory configured and can be changed by the user.

Table 5. Analog and Digital Solder Pads Descriptions

Jumper Name Default Function

P9 SDO 1to3 SDO Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P34.
P16 DIN 1to3 DIN Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P35.
P17 CNV 1to3 CNV Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P36.
P18 SCK 1to3 SCK Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P33.
P19 BUSY 1to3 BUSY Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P37.
P27 RESET 1to3 RESET Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P38.
P28 PD 1to3 PD Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P39.
P29 cs 1to3 CS Interface Select. Pad 1 to Pad 3 for FPGA; Pad 2 to Pad 3 for P3 to P40.
P25 DSPCLK Soldered CED Clock Source.
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Table 6. Power Supply Solder Pads

Jumper | Name Default Function

P6 VDDH Soldered | VDDH Supply.

P13 VSSH Soldered | VSSH Supply.

P8 AVDD +5VA AVDD Supply. Selection of +5 V A, analog supply from the CED board or +5 V from U3.

P10 - Soldered | VIO Supply. This solder pad can be used to power the FPGA VIO and ADAS3022 VIO together.

P11 - Soldered | FPGA VIO Supply. Supplied from U8, 3.3 V, dedicated digital supply.

P12 VIO Open VIO Supply. Selection of 2.5 V (2V5), 3.3 V (3V3), or DVDD (5V). Note that the ADAS3022 digital outputs are set to
this level and are directly wired to the FPGA, U6, which is 3.3 V max. When using the 5 V setting, the ADAS3022
outputs, SDO and BUSY must be resistively divided using the 0603 pads provided on the evaluation board. For
this reason, P10 is used as the default.

P14 DVDD +5VD DVDD Supply. Selection of +5 V digital, +5 V D, and +5 V from U3.

P15 VDRV- | —5VA U20 V—-/P34 Supply. Selection of =5 V A, analog supply from the CED board or GND.

P33 VDRV+ | +5VA U20 V+/P35 Supply. Selection of +5 V A, analog supply from the CED board or +5 V from U3.

P34 U4 V+ VDRV+ U4 V+ Supply. Selection of VDRV+ or U2.

P35 U4 v- VDRV- U4 V- Supply. Selection of VDRV- or GND.

P22 —15V Soldered | —15V CED Supply.

P23 —5VA Soldered | —5V A (Analog) CED Supply.

P24 +5VA Soldered | +5V A (Analog) CED Supply.

P26 +5VD Soldered | +5V D (Digital) CED Supply.

P30 +15V Soldered | +15V (Analog) CED Supply.

Table 7. Test Points (By Signal Type)

Test Point Type Description

INO_I Analog Input Path for INO Input.

INT_I Analog Input Path for IN1 Input.

IN2_I Analog Input Path for IN2 Input.

IN3_I Analog Input Path for IN3 Input.

IN4_| Analog Input Path for IN4 Input.

IN5_I Analog Input Path for IN5 Input.

IN6_I Analog Input Path for IN6 Input.

IN7_I Analog Input Path for IN7 Input.

COM_I Analog Input Path for COM Input.

REF Analog Input Direct Connection to ADAS3022 REFx Pin.
REFIN Analog Input Direct Connection to ADAS3022 REFIN Pin.
CNV Digital Input Direct Connection to ADAS3022 CNV Pin.
BUSY Digital Output Direct Connection to ADAS3022 BUSY Pin.
SDO Digital Output Direct Connection to ADAS3022 SDO Pin.
SCK Digital Input Direct Connection to ADAS3022 SCK Pin.
PD Digital Input Direct Connection to ADAS3022 PD Pin.
RESET Digital Input Direct Connection to ADAS3022 RESET Pin.
DIN Digital Input Direct Connection to ADAS3022 DIN Pin.
CSB Digital Input Direct Connection to ADAS3022 CS Pin.
MSCL Digital Output Eval Board Master Clock Form Y3, 100 MHz Oscillator.
VDDH Power Direct Connection to ADAS3022 VDDH Pin.
VSSH Power Direct Connection to ADAS3022 VSSH Pin.
AVDD Power Direct Connection to ADAS3022 AVDD Pin.
DVDD Power Direct Connection to ADAS3022 DVDD Pin.
VIO Power Direct Connection to ADAS3022 VIO Pin.
+5VA Power Connected to P24; CED +5 V A.

-5VA Power Connected to P23; CED -5V A.

+15V Power Connected to P30; CED +5 V A.

-15V Power Connected to P22; CED -5V A.

+5VD Power Connected to P26; CED +5 V D.

GND(s) Power Connected to Eval Board GND Plane.
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EVALUATION BOARD SOFTWARE

SOFTWARE INSTALLATION
Close major Windows applications prior to installing the software.
System Requirements

e  Windows XP (SP2, 32-bit), Windows Vista (32-bit or
64-bit), or Windows 7 (32-bit or 64-bit)

e  TUSB 2.0 (for CED board)

¢ Administrator privileges

Website Download

The evaluation board software is available for download from
the evaluation board page on Analog Devices website. Click the
setup.exe file to run the install. The default location for the
software is C:\Program Files (x86)\Analog Devices\
ADAS3022 Evaluation Software.

Install the evaluation software before connecting the evaluation
board and EVAL-CED1Z board to the USB port of the PC to
ensure that the evaluation system is correctly recognized when
connected to the PC.

There are two parts of the software installation process:

e ADAS3022 evaluation board software installation

e EVAL-CEDIZ board driver installation

Figure 4 to Figure 9 show the separate steps to install the
ADAS3022 evaluation software, while Figure 10 to Figure 12
show the separate steps to install the EVAL-CED1Z drivers.
Proceed through all of the installation steps to allow the soft-
ware and drivers to be placed in the appropriate locations.
Only connect the EVAL-CED1Z board to the PC after the
software and drivers are installed.

-
-1 ADAS3022 Evaluation Software

Itis strongly recommended that you esit all programs before running this ) ‘
installer. Applications that run in the backaround, such as virus-scanning
utilitie, might cause the installer to take longer than average ta complete.

Flease wait while the installer initializes

Lancel

Figure 4. ADAS3022 Evaluation Software Installer

11064-104

.| ADAS3022 Evaluation 1 ]

|
Destination Directory

Select the primary installation directom.

All sottware will be mstalled in the following locations. To install software into &
different location, click the Browse button and select anather dirsctory,

Directory for ADAS3022 Evaluation Software

|C:\F'logram Files [+38)\inalog Devices\ADAS 3022 4 | [ Bromse..
Directary for Mational Instruments products
|C:\F‘|ogram Files [B6]\Mational Instruments’, | I Browse...
{ £< Back ‘E Mest 22 j { LCancel J

Figure 5. ADAS3022 Evaluation Software Destination Directory

| ADAS3022 Evaluation Softw

License Agreement
“You must accept the licenses displayed below to proceed

NATIONAL INSTRUMENTS SOFTWARE LICENSE AGREEMENT ':I

INSTALLATION MNOTICE: THIS IS A CONTRACT. BEFORE YOU DOWMNLOAD THE SOFTYWARE
ANDIOR COMPLETE THE INSTALLATION PROCESS, CAREFULLY READ THIS AGREEMENT. BY
DOVYNLOADING THE SOFTWARE AMDIOR CLICKING THE ARPLICABLE BUTTOM TO
COMPLETE THE INSTALLATION PROCESS, YOU CONSENT TO THE TERMS OF THIS
AGREEMENT AMD YOU AGREE TO BE BOUMD BY THIS AGREEMENT. IF YOU DO NOTWISH TO
BECOME A PARTY T THIS AGREEMENT AMD BE BOUND BY ALL OF TS TERMS AKD
CONDITIONS, CLICK THE APPROPRIATE BUTTON TO CANCEL THE INSTALLATION PROCESS,
D0 NOT INBTALL OR USE THE BOFTWARE, AMD RETURN THE SOFTWARE WITHIN THIRTY
(30) DAYS OF RECEIPT OF THE SOFTWARE (WITH ALL ACCOMPANYING WRITTEN MATERIALS,
ALOMG WITH THEIR COMTAIMERS) TO THE PLACE YOU OBTAINED THEM. ALL RETURMS
SHALL BE SUBJECT TO MI'S THEK CURRENT RETURM POLICY. -

The zoftware to which this Mational [nstruments license applies it ADAS3022 Evaluation Software,

acoept the License dgreement

() | da nat accept the License Agresment.

{ << Back ‘[_ et »> M LCancel J

Figure 6. ADAS3022 Evaluation Software License Agreement

- = B
L1l ADAS3022 Evaluation Softwar [E=EEER)
e e

(| Start Installation
Review the following summarny before continuing.

Uparading
« Halional Instruments system components

Adding or Changing
* ADAS3022 Evaluation Software Files

Click the Mest button to beqin installation. Click the Back button to change the installation settings.

Iiave File... J { << Back ‘[_ Mest »5 j { Cancel

Figure 7. ADAS3022 Evaluation Software Start Installation

Rev. A | Page 8 of 32
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Installing

Please wait while CED Drivers Install 3.4.2.0 is being installed.

Installing Drivers
-

Extract: dpinst_amdé4.exe... 100%
Oukput Falder: C:\Program Files\Analog Devices\CED 64\Drivers
Skipped: dpinst.exe

Skipped: dpinst.xml

Cukput Falder: C:YProgram Files\Analog Devices\CED 64\Drivers
Skipped: adi_ced1_g4.cat

Skipped: ADI_CED1 sys

Skipped: ADI_CED1_64.inf

Skipped: adi_cedla.spt

Installing Drivers

TE—— 420000

Overall Progress: 35% Complete

Copying new files.

m

Mk =

11064-108

<4 Back Next>> g
Figure 8. ADAS3022 Evaluation Software, Installation In Progress Figure 11. CED Drivers Install Setup Wizard, Installation In Progress
Installation Complete
Completing the CED Drivers Install
3.4.2.0 Setup Wizard
The installer has finished updating pour spsten,
CED Drivers Install 3.4.2.0 has been instaled on wour
cornpuker,
Click Firish to close this wizard,
<< Back Eirish § Cancel %
Figure 9. ADAS3022 Evaluation Software Installer, Installation Complete Figure 12. CED Drivers Install Setup Wizard, Installation Completed
@H CED Drivers Install 3.4.2.0 Setup. i |pi=m) - =
: - d ADAS3022 Evaluation Spf_ [
alsonty doithe CED Brivets:insidil I “ou must restart pour computer to complete this operation
3.4.2.0 Setup Wizard @ ’
o ) ] If you need to install hardware now, shut down the computer, If pou
This wizard will guide you through the installation of CED choose to restart later, restart your computer before running any of this
Drivers Install 3.4.2.0.
software.
1t is recommended that vou close all other applications
befare starting Setup. This will make it possible ta update
relewvant system files without having to reboot your
computer. Restart ] | Shut Down ] | Restart Later e
Click Install ko start the installation, §

Figure 13. Computer Restart Notice

Figure 10. CED Drivers Install Setup Wizard

11064-110
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On some PCs, the Found New Hardware Wizard may show
up. If so, follow the same procedure to install it properly.

The Device Manager can be used to verify that the driver was
installed successfully.

L% Device Manager

]
# B8 ADI Development Tools
# ¥ Computer

+ e Disk drives

i Bl Mienlaw adantare

11064-006

Figure 14. Device Manager

Troubleshooting the Installation

If the driver was not installed successfully, the Device Manager
displays a question mark for Other devices because Windows
does not recognize the EVAL-CED1Z board.

L, Device Manager

File Acton View Hebp

«= @8R a

[ E Batteries

+ (& Biometric
i+ H§ Bluetooth
# 1§ Computer
# <ge Disk drives
& B Display adapters
[+ DVD/CD-ROM drives
[# (&3 Human Interface Devices
" @ IDE ATAfATAPI controllers
+ & IEEE 1394 Bus host controflers
* > Keyboards
+ ") Mice and other painting devices
O Modems
= W Monitors
(+ H8 Network adapters
= @ Other devices
&} USE Device
# [@ PCMCIA adapters
+ 5 Ports (COM&LPT)
+ 9 Processors

11064-007

Figure 15. Device Manager Troubleshooting

The USB Device can be opened to view the uninstalled
properties.

USB Device Properties

General | Drver | Details|

.\> USB Device

Device type: Other devices

Mamufacturer: Unknown

Location: Location 0 (USB Device)
Device status
[The drivers for this device are not installed. (Code 28) .
| To reinstall the drivers for this device, click Reinstall Driver. ‘

[ Reinstall Driver... ]

Device usage:
;_Ese this device (enable) v |

Lok J[ concsl |

11064-008

Figure 16. USB Device Properties

This is usually the case if the software and drivers were installed
by a user without administrator privileges. If so, log on as an
administrator with full privileges and reinstall the software.
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POWERING UP THE BOARD

The evaluation board, as configured from the factory, uses the
local LDOs for power where necessary. A +15 V dc lab supply

must be connected to the board. Test points (yellow and white)
are provided for these external supplies.

Figure 17. Test Points

RUNNING THE SOFTWARE WITH THE HARDWARE
CONNECTED

The evaluation board includes software for analyzing the
ADAS3022. The EVAL-CEDI1Z is required when using the
software. The software is used to perform the following tests:

e  Histogram tests for determining code transition noise (dc)
¢  Time domain analysis

e  Fast Fourier transforms (FFT) for signal-to-noise ratio
(SNR), SNR and distortion (SINAD), total harmonic
distortion (THD), and spurious free dynamic range (SFDR)

This evaluation software should be located at
<local_drive>:\Program Files\Analog Devices\ADAS3022
Evaluation Software.

In order to launch the software, click Start>All Programs>
Analog Devices\ADAS3022 Evaluation Software. You can
then apply the signal source and capture the data.

To uninstall the program, click Start>Control Panel>Add or
Remove Programs>Analog Devices ADAS3022 Evaluation
Software.

Refer to Figure 18 to Figure 31 for further details and features of
the software.
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SOFTWARE OPERATION

This section describes the full software operation and all windows
that appear. When the software is launched, the panel opens
and the software searches for hardware connected to the PC.
The user software panel launches, as shown in Figure 18. The
labels listed in this section correspond to the numbered labels
in Figure 18.

File Menu (Label 1)

The File menu, labeled 1 in Figure 18, provides the following:
e  Save Captured Data saves data to a .csv file.

e  Take Screenshot saves the current screen.

e  Print prints the window to the default printer.

e  Exit quits the application.

Edit Menu (Label 2)
The Edit menu, labeled 2, provides the following:

o Initialize to Default Values: This option resets the
software to its initial state.

Help Menu (Label 3)

The Help menu, labeled 3, offers help from the following sources:

¢  Analog Devices website

e  User Guide

e  Context Help
e About

B Analog Devices ADAS3022 16-bit, 1MSPS, 8-Channel Data Acquisition System

Throughput (Label 4)

The default throughput (sampling frequency) is 1,000 samples
per second (SPS). The ADAS3022 is capable of operating a
maximum sample frequency up to 1,000 kSPS.

Samples (Label 5)

Select the number of Samples to analyze when running the
software. This number is limited to 65,536 samples.

Single Capture (Label 6) and Continuous Capture

(Label 7)

Single Capture performs a single capture, whereas Continuous
Capture performs a continuous capture from the ADC.

Tabs

There are four tabs available for displaying the data in different
formats.

e Time Domain

e  Histogram

e  Spectrum

e  Summary

To exit the software, go to File>Exit.

Fie Edit Hep

O] : ANALOG
ADAS3022 Evaluation Software DEVICES
Configure | Time Domain Histogram | Spectrum | Summary | Samples [s5536 v [_single capture ] [Continuous Capture|

DvDD

vio RESET PD
O 0>

DIFF  DIFF TQ
PAIR com

VDDH  AVDD
)
&,

ADAS3022

INO/IN1

IN2/IN3

O cNv

@ LOGIC!

INTERFACE LBy

Throughput

Qes |  1000|ksps

IN4/INS

INB/IN7

:Data analysis complete.

]

VSSH AGND DGND REFx

r['

CPHA (SPI)

10516:001

Update CFG RESET
@ 5usy|

Version 3.0

11064-118

Figure 18. Setup Screen
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P Prompt User for Input >

MLIX Settings

INx (CFG[14:12])
\ N1 v

SEQ (CFG[5:4])
\ Disable(d) w ‘

COM (CFG[11])
Channel-to-COM |%
Channel Pairs
J Channel-to-COM

Figure 19. Dialogue Box for Label 8, MUX Settings

P Prompt User for Input

MUX Settings

INx (CFG[14:12])
INO v

+ INO
IN1
INZ
Nz
InNg
INS
ING
N7

11064-120

Figure 20. Dialogue Box for Label 8, Input Channel Options

| - Prompt User for Input

MUX Settings

INx (CFG[14:12])
IND - IN1 v
 IND - IN1
INZ - IN3
IN4 - IN5
ING - IN7

Channel Pairs v

11064-121

P Mux Settings

MUX Settings

INx (CFG[14:12])
| INO - IN1 v

SEQ (CFG[5:4])
Disable(d) |l
J Disableld)
Initialize Advanced
Initizlize Sequencer

11064-122

Figure 22. Dialogue Box for Label 8, Sequence Options

11064-119

Figure 21. Dialogue Box for Label 8, Alternate Input Channel Options
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£} Advanced Sequencer Gai

IN1| PGIA gain = 0.20, Vin = £20.4800V |+ [0 |asro
2| PGIA gain = 0.16, vin = £24.576V <0000 |AsR1
Inz|  PGIAgain = 0.40, Vin = £10.2400v e
PGIA gain = 0.80, Vin = £5.1200V
PGIA gain = 1.5, Vin = £2.5600V
PGIA gain = 3.2, Vin = +1.2800V

PGIA gain = 6.4, Vin = 0.6400¥
PGIA gain = 12.8, Vin = +0.3200V
 PGIA gain = 0.20, Vin = +20.4800V

Configuration

P PGIA Settings

PGIA Settings

PGA (CFG[9:7])

PGIA gain = 0.16, Vin= % 24.576 V »

¢ PGIA gain = 0.16, Vin= + 24.576 V
PGIA gain = 0.40, Vin= £ 10.2400 V
PGIA gain = 0.80, Vin=+ 5.1200 V
PGIA gain = 1.6, Vin=+ 2.5600 V
PGIA gain = 3.2, Vin=+ 1.2800 V
PGIA gain = 6.4, Vin= = 0.6400 V
PGIA gain = 12.8, Vin=+ 0.3200 V
PGIA gain = 0.20, Vin= + 20.4800 V

Figure 24. Dialogue Box for Label 9, PGIA Settings

P AUX/MUX

ALY MLX Settings

AUKMUX

MUK ONLY b
INO-INX + AUX
o MUK ONLY

Conversion Mode Settings

Conversion Mode
Normal Mode |+
Turbo Mode
4 Normal Mode

P Reference Settings

Reference Settings

Reference Enable

| REFERENCE ENABLED L
REFEREMCE DISABLED

‘ + REFERENCE ENABLED

Figure 27. Dialogue Box for Label 12, Reference Settings

Figure 25. Dialogue Box for Label 10, AUX/MUX Settings

11064-123

Figure 23. Dialogue Box for Label 8, Advanced Sequencer PGIA Gain

11064-124

11064-125

11064-126

Figure 26. Dialogue Box for Label 11, Conversion Mode Settings

11064-127
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Start Up
Refer to the numbered labels in Figure 18. Clicking the blue
buttons reveals the dialog boxes shown in Figure 19 through
Figure 27.

To begin evaluating the device, the on-board supplies must be
enabled.

e  RESET resets the ADAS3022 device to a known state.
Click RESET twice: once to reset the ADAS3022 and
again to bring it out of the reset state. Note that the
CFQG is also reset to the default condition.

e  Reference Selection: At this time, it is recommended
to use the evaluation board’s externally generated
reference (default). To select the on-chip reference,
remove the P5 and P7 jumpers and click the button in
the REF block to display the Reference Settings
dialog box, then choose REFERENCE ENABLED.

e Auxiliary (AUX+) Channels Selection: The ADAS3022
allows the user to run it in default MUX ONLY mode
or by clicking on it to select the auxiliary channel
input pair (AUX+, AUX-) INO-INX AUX in normal
mode or sequencer mode. The INO-INX AUX option
converts a dedicated channel through the internal
differential auxiliary channel pair (AUX+, AUX-)
with the specified input range of +Vgge. This option
bypasses the MUX and programmable gain instrumen-
tation amplifier stage, allowing direct access to the
SAR ADC core.

e  Update CFG: If the default configuration (channel, chan-
nel configuration, reference, and so on) is acceptable,
clicking Update CFG writes to the ADAS3022 con-
figuration register (CFG). The ADAS3022 device is
configurable using a 16-bit on-chip register, CFG (refer
to the ADAS3022 data sheet for more details). Note that
after changing any of the CFG register, this button
must be clicked for the new setting to take effect.

Input Channel

To select the input channel, make a selection from the pull-
down menu (see Figure 20).

Channel Pairing
The channels can be paired (up to 4 maximum) or all channels
can be referenced to the COM input (see Figure 21).

Programmable Gain

The most useful and innovative feature of the ADAS3022 is the
on-chip programmable gain instrumentation amplifier. This
amplifier has the added flexibility of allowing for inputs ranging
from +0.64 V to £24.574 V. Select the appropriate setting for the
input voltage span, not including any common-mode signals,
since they are rejected. Note that the ADAS3022 devices do not
need the usual level shifting that is common in SAR ADC
systems. The ADAS3022 devices can accommodate fully
differential, single ended, and bipolar input signal types.

Software Controls
Within any of the chart panels, these controls are used to
control the display.

-
_+_' Controls the cursor.

-
Controls zooming in and out.

ﬂi Controls panning.
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TIME DOMAIN TAB

Figure 28 illustrates the Time Domain tab. The ADAS3022
output is twos complement output; however, the software
outputs the results in straight binary.

P Analog Devices

nnel Data Acquisition System

Note that Label 1 shows the Waveform Analysis that reports
the amplitude recorded from the captured signal in addition to
the frequency of the signal tone, and Label 2 shows that Y-axis
units can be displayed in volts or code (LSB).

File Help
Configure | Time Domain ‘ Histogram H Spectrum || Summary‘ I ‘65536 .v.| [ single capture | [Continuous Capture] o
10.000000
8.000000 Plot Legend
6.000000 E |V
4.000000 )
% 2.000000
W
=
a 0.000000
g
5 -2.000000
-4.000000
-6.000000
-8.000000
-10.000000
o 5000 10000 15000 20000 25000 30000 35000 40000 45000 50000 55000 60000 65535
Time
@Y—Axcs Units X
Volts. @8 @ Waveform Analysis
‘Code (LSBS)
2 Volts min|  772)1se | -9.00875]v RMS|  7.07|vrms
Mean| 32769.1|LSB | 0.00034 |V Transition Noise| 7.07E+0|Vrms
Max 64767 || s
Pk-Pk 63995 |5 | 19.99844 |V
]
Data analysis complate. Version 3.0 . Busy $
8

Figure 28. Time Domain Tab
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HISTOGRAM TAB

The histogram is most often used for dc testing or ac testing,
where a user tests the ADC for the code distribution for dc input
and computes the mean and standard deviation, or transition
noise, of the converter, and displays the results. Raw data is
captured and passed to the PC for statistical computations.
Figure 29 shows the Histogram tab.

To perform a histogram test,

1. Select the Histogram tab.

2. Click Single Capture or Continuous Capture.
DC Testing

To test other dc values, apply a source to the selected analog
inputs IN[7:0]_I via test points or P1. It may be required to

P Analog Devices ADAS3022 16-bit, 1MSPS, 8-Channel Data Acquisition System

filter the signal to make the dc source noise compatible with
that of the ADC. Note that 0805 and 0603 SMT pads are
provided in each signal path and can be used for filtering the
source, if necessary.

AC Testing

Figure 29 shows the histogram for a 1 kHz sine wave applied to
the analog inputs IN[7:0]_I via test points or P1 from a quality
precision signal source, such as Audio Precision. It may be
required to filter the input signal from the ac source. There is no
suggested band-pass filter, but consider all choices carefully.
The Waveform Analysis (Label 1) chart displays the various
measured histogram values for the ADAS3022.

90

File Help
ADAS3022 Evaluation Software 3 580cE
Configure Time Domain ‘ Histoggm | Spectrum Summary | Same\es E?B_S_i! [ Single Capture ][Cﬂntmunus Capture]7@
100 T -
el ]

80

70

60

50

Qccurance

40

30

20

10

o

@ Waveform Analysis

o 5000 10000 15000 20000 25000 30000 332000 40000 45000 50000 55000 60000 65000

Min| 772|LsB [ 008875 v
e
Mean| 32769.1|LSE [ 0.00034]V

Max|  ©64767| gp | 9.99969],

PkPk| 63995|isp | 19.09844 v

SRR

RMSI 7.07 !Vrms

Transition Noise | 7-U7E+inm5

|Data analysis complete.

Version 3.0 " ] Busﬂ

11064-128

Figure 29. Histogram Tab
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SPECTRUM TAB

Figure 30 shows the FFT spectrum capture tab. This tab tests
the traditional ac characteristics of the converter and displays a
fast Fourier transform (FFT) of the results. As in the histogram
test, raw data is captured and passed to the PC where the FFT is
performed, displaying SNR, SINAD, THD, and SFDR.

To perform an ac test, apply a sinusoidal signal to the evaluation
board to any of the analog inputs IN[7:0]_I, either via test
points or P1. Very low distortion—a better than 130 dB input
signal source, such as Audio Precision)—is required to allow
true evaluation of the part. One possibility is to filter the input

P Analog Devices ADAS3022 16 bit, 1MSPS, 8-Channel Data Acquisition System

signal from the ac source. There is no suggested band-pass
filter, but carefully consider the choices. Figure 30 displays the
results of the captured data.

e The top part of the image displays the FFT results
including SNR, dynamic range, THD, SINAD, and noise
performance (see Label 1).

L]

The lower part of the image displays the fundamental
frequency and amplitude in addition to the 2" to 5%
harmonics (see Label 2).

Fie Help
- . e —— _ R
Configure | Time Domain | Histogram ‘ Spectrum \ Summary ' Samples (65536 »| [_Single Capture ] [Continuous Capture] @
0
HAE
20
-40
60
-1
5 -0
=
£ -100
<
-120 {
-140
-160
-180 |
0 50000 100000 150000 200000 250000 300000 350000 400000 450000 500000
Frequency
FFT Results
Max Amplitude [9.998 | v RTI [64764.C)LSB SNR (FS/N)[91.144 | ggFs
MIN Amplitude|-0.998 |vRT1 [774.00 LsB SNR (SIN/N)[90.908 | daFs
PK PK Amplitude| 19.997 | vRTI [63990.c/LsB i —
THD|-105.122
Mean Amplitude| -258.0E| VRTI |32767.1/L5B [05122 [ ds s
v sinap[90.883 |
Fund. Frequency | 20.004k |Hz 7‘ a8.ES
[105.315 |
Fund. Amplitude |- | SFOR{I05:015 [dBFS
RMSL?.n?n V RTI Noise Floor| 7141.727J dBFs Show Spectrum Analysis|
iData analysis complete. Version 3.0 . Busy
Spectrum Analysis
Frequency Amplitude
Fund[2.000E+4| Hz  [-0.235 | dBFS
ond|4.001E+4| Hz  [-134.668 | dBFS
4th[B.002E+4 | Hz  [-134.048 | dB Fs
s5th|1.000E+5| Hz  [-112.396 | dB FS
Show FFT Results
@
i - il &
| Data analysis complete. Version 3.0 . Busyj g
— | &

Figure 30. FFT Spectrum with FFT Results (Top) and with Spectrum Analysis Results (Bottom)
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SUMMARY TAB

Figure 31 shows the Summary tab, which summarizes all the
data capture information and displays it in one panel with a
synopsis of the information, including key performance
parameters such as SNR, THD, and SINAD.

P Analog Devices ADAS3022 16-bit, 1MSPS, 8-Channel Data Acquisition System

£:5

w

Fie Help
5 ANALOG
ADAS3022 Evaluation Software DDEVICES
| Configure | Time Domain | Histogram | Spectrum | Summary | Samples (65536 w| [_Single Capture ] [Continuous Capture] 0
| | | |
Histogram FFT
120 0
20
100
-40
o 80 » 60
g 2.100 |
= a0 <120 |
-140
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Figure 32. Schematic, DUT, Analog

EVALUATION BOARD SCHEMATICS AND ARTWORK
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PRODUCTS ON THIS EVALUATION BOARD

BILL OF MATERIALS
Table 8.
Qty | Reference Description Part Description Value Manufacturer Part Number Instructions
5 U1toU3,U8,U12 IC-ADI LDO - Analog Devices ADP3334ACPZ
2 uU10, U11 IC-ADI LDO - Analog Devices ADP1715ARMZ
1 u20 IC-ADI OPAMP - Analog Devices AD8032ARZ
1 U4 IC-ADI OPAMP - Analog Devices ADA4841-2YRZ
1 Al IC-ADI REFERENCE | - Analog Devices ADR434ARMZ
1 A2 IC-ADI REFERENCE | - Analog Devices ADR381ARTZ
1 ué IC-CYCLONE Il - Altera Devices EP2C5F256C7N
1 us IC SERIAL CONFIG - Altera Devices EPCS4SI8N
1 Y3 IC CRYSTAL OSC 100 MHZ C-MAC SPX0009437-CFPS-73
22 C108,C111 to C131 CAP X7R 0402 0.1 pF Murata GRM155R71C104KA88D
2 C45,C89 CAP X7R 0508 0.1 pF TDK C1220X7R1E104K
1 c107 CAP NP0 0603 100 pF Phycomp 2238867 15101 DNI
6 C17, C20, C24, C25, C36, CAP X8R 0603 0.1 pF Murata GRM188R7E104KA01D
88
6 C66 to C68, C79 to C81 CAP X7R 0603 DNI
11 C38,C65,C70,C71,C72, CAP X7R 0805 0.1 pF Murata GRM21BR71H104KA01L
C73,C75,C76,C77,C78,
C92
7 (8, C29to0 C31,C86,C109, | CAP COG 0805 1000 pF Murata GRM2165C2A102JA01D
c110
11 C43,C44, C46, C47, C49, CAP NPO 0805 2700 pF Murata GRM2165CT1H272JA01D
C50, C57, C59, C60, C62,
c63
9 C1,C3,C4,C6, C10, C51, CAP NPO 0805 2700 pF Murata GRM2165C1H272JA01D | DNI
C53, C55,C56
8 C2, C5,C48,C52,C54, CAP NPO 0805 5600 pF Murata GRM2195C1H562JA01D | DNI
C58,C61, C64
15 C7,C9,C18,C19,C21, CAP X5R 0805 2.2 yF Murata GRM21BR71E225KA73L
C22,C26t0 C28,C32to
C34, C37,C85,C87
10 C11to C16,C23,C35,C69, | CAP X5R 0805 10 pF Murata GRM21BR61CT06KE15L
C74
2 C84, C90 CAPTANT 10 pF AVX TAJAT06KOT0RNJ
7 C39to C42,C91,C93,C94 | CAP 0805 Murata - DNI
R94 RES 0402 0 Panasonic-ECG ERJ-2GEOR00OX
4 R32,R72,R73,R103 RES 0603 - Panasonic-ECG - DNI
6 R2,R71,R125,R126,R136, | RES 0603 - Panasonic-ECG - DNI
R151
6 R30, R31,R59,R137,R137, | RES 0603 0 Panasonic-ECG ERJ-3GEYOROOV
R151
9 R60 to R68 RES 0603, 5% 50 Panasonic-ECG ERJ-3EKF49R9V
18 R74 to R78,R121,R122, RES 0603, 5% 10K Panasonic-ECG ERJ-3EKF1002V
R128,R130,R132,R134,
R138 to R144
2 R125,R126 RES 0603, 5% 15K Yageo RCO0603FR-0715KL DNI
2 R13, R55 RES 0603, 1% 140K Panasonic-ECG
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Qty | Reference Description Part Description Value Manufacturer Part Number Instructions

14 R1, R24 to R26, R29, R80 RES 0805 - Panasonic-ECG - DNI
to R82, R85, R86, R95, R97,
R99, R100

25 R7 to R9, R19 to R23, R41 RES 0805 0 Panasonic-ECG ERJ-6GEYOROOV
to R49, R69, R70, R90 to
R93, R96, R101
R57,R58 RES 0805, 1% 22 Panasonic-ECG ERJ-6ENF22R0OV

9 R34 to R40, R50, R55 RES 0805, 1% 90.9 Panasonic-ECG ERJ-6ENFOOR9OV

1 R27 RES 0805, 1% 365 Panasonic-ECG ERJ-6ENF3652V

9 R33,R52 to R54, R79,R83, | RES 0805, 1% 499 Panasonic-ECG ERJ-6ENF4990V
R84, R87, R88

1 R28 RES 0805, 1% 590 Panasonic-ECG ERJ-6ENF5902V

2 R89, R145 RES 0805, 1% 604 Panasonic-ECG ERJ-6ENF6040V

2 R3,R5 RES 0805, 5% 1K Panasonic-ECG ERJ-6ENF1001V

2 R4, R6 RES 0805, 5% 2K Panasonic-ECG ERJ-6ENF2001V

6 R10to R12, R98, R102, RES 0805, 5% 10K Panasonic-ECG ERJ-6ENF1002V
R135

1 R16 RES 0805, 1% 649K Panasonic-ECG ERJ-6ENF6492V

2 R14, R56 RES 0805, 1% 787K Panasonic-ECG ERJ-6ENF7872V

1 R18 RES 0805, 1% 95.3K Panasonic-ECG ERJ-6ENF6042V

1 R17 RES 0805, 1% 107 K Yageo RCO805FR-07300KL

1 R15 RES 0805, 1% 210K Panasonic-ECG ERJ-6ENF2103V

2 CR1,CR2 LED Green Chicago MINI LAMP CMD28-21VGCTR8T1

3 P5, P7,P31 CONN-3 PIN MALE Breakaway Samtec TSW-103-08-G-S

1 P2 CONN-10 PIN MALE | RA, shroud 3M 2510-5002UB

1 P1 CONN-26 PIN MALE | Shroud 3M 30326-6002HB

1 P3 CONN-40 PIN MALE | RA, Shroud 3M 2540-6002UB

1 P4 CONN-96 PIN MALE | RA, DIN ERNI 533402

6 GND(S) Test point Black Components Corp TP-104-01-00

2 +15V, MCLK Test point Yellow Components Corp TP-104-01-04

4 REF, +5V A, +5V D, REFIN | Test point Red Components Corp TP-104-01-02

2 -15V,-5VA Test point White Components Corp TP-104-01-09

26 PD, CNV, CSB, DIN, Test point Blue Components Corp TP-104-01-06

SCK, SDO, VIO,
AVDD, BUSY, DVDD,
VDDH, VSSH,
AUX+, AUX-,
COM_, INO_I-IN7_1,
RESET, VDRV+,
VDRV-
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RELATED LINKS

Resource Description

AD8032 Product Page, AD8031/AD8032, Low Power, Low Noise Amplifier

ADR434 Product Page, ADR434, 4.096 Precision Reference

ADP1715 Product Page, ADP1715, 500 mA Low Dropout CMOS Linear Regulator with Soft Start

ADP3334 Product Page, ADP3334, High Accuracy Low lo, 500 mA, ANYCAP®, Adjustable Low Dropout Regulator
EVAL-CED1Z Product Page, Converter and Evaluation Development board

AN-931 Application Note, Understanding PulSAR ADC Support Circuitry

AN-932 Application Note, Power Supply Sequencing
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NOTES

ESD Caution
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection
‘m circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board"), you are agreeing to be bound by the terms and conditions
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc.
("ADI"), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal,
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (i) permit any Third Party to access the Evaluation Board. As used herein, the term
“Third Party”includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board.
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER'S POSSESSION OR USE OF
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI'S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable
United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

©2012-2014 Analog Devices, Inc. All rights reserved. Trademarks and AN ALOG
registered trademarks are the property of their respective owners.
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